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In This Guide…
This guide contains information to install the Agilent 6460 
Triple Quad Mass Spectrometer (Model K6460) System.

1 Instrument Installation

This chapter describes the steps that are needed to install 
the K6460 Triple Quad MS.

2 Software Installation and Configuration

This chapter describes the steps that are needed to install 
the MassHunter software.

3 Installation Completion and System Verification

In this chapter, you finish the hardware setup.

4 Installation and Verification of the G1947B APCI Source

This chapter contains the steps needed to install and verify 
the operation of the APCI source.

5 Other Setup Tasks

This chapter contains tasks that are related to setting up 
your Triple Quad instrument.

6 Reference

This chapter contains parameters for verifying performance.
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6460 Triple Quad Mass Spectrometer (Model K6460) System
Installation Guide
1
Instrument Installation
Step 1. Unpack and set up the K6460 Triple Quad MS 8
Step 2. Prepare to install the system 9
Step 3. Set up the Agilent MS40+ pumps 14
Step 4. Connect the K6460 Triple Quad MS 17
Step 5. Install the spray chamber 23
Step 6. Install the Agilent LC system 27

This chapter describes the steps that are needed to install the K6460 Triple 
Quad MS.

Figure 1 K6460 Triple Quad MS
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1 Instrument Installation
Step 1. Unpack and set up the K6460 Triple Quad MS
Step 1. Unpack and set up the K6460 Triple Quad MS

1 Carefully examine all containers for external signs of damage. If damage is 
discovered, immediately contact the carrier and the Agilent Service 
Management.

Retain shipping containers and material until contents are checked for 
completeness and instrument performance is verified.

2 Check off each item on the packing list, and verify the serial numbers.

3 Record the serial numbers in the installation documentation. 

4 Report any discrepancies to Agilent Technologies.

5 Check that site preparation is complete, which includes power and gas 
supplies and chemical supplies needed for installation and performance 
verification.

6 Check the line voltage in the lab.

Verify the proper line voltage and outlet ratings according to the 
instructions given in the Site Preparation Guide.

NOTE Do not open the shipping containers until an Agilent representative is present to verify the 
contents of each carton. Warranty claims for missing items are honored only if an Agilent 
representative is on site to verify the contents of each shipping container as it is 
unpacked.

Checkout and tuning samples are shipped separately to comply with shipping regulations 
and to ensure prompt delivery. Make sure that these samples have been stored correctly, 
as indicated in the instructions in the box.
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Instrument Installation 1
Step 2. Prepare to install the system
Step 2. Prepare to install the system
Before you begin, check that you have these parts:

• Utility knife and needle nose pliers

1 Unpack and set up the K6460 Triple Quad MS.

a Cut the tie wraps around the package. See Figure 2.

Figure 2 K6460 Triple Quad MS shipping container

b Lift the boxes off the top of the instrument. See Figure 3.
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1 Instrument Installation
Step 2. Prepare to install the system
Figure 3 Instrument unpacked on shipping pallet (K6460 pictured)

c Remove the front, top, right, back-left, and lower front-left cosmetic 
covers so that you can remove the shipping brackets. You do not need to 
remove the upper front-left cover. 

To remove the top cover, remove the two screws at the back side of the 
top cover that secure the back of the top cover to the instrument chassis 
(see Figure 4). These screws are only needed when shipping the 
instrument. You do not need to reinstall the screws when you reinstall 
the top cover.
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Instrument Installation 1
Step 2. Prepare to install the system
Figure 4 Remove shipping screws from back of top panel. One of the screws to remove 
is circled in this picture.

d Remove the shipping brackets (a total of 7). You will need to use a 13-mm 
wrench.
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1 Instrument Installation
Step 2. Prepare to install the system
Figure 5 Triple Quad on shipping pallet with covers removed (K6460 pictured)

e Take an inventory of the contents of the packages.

f Record serial numbers. The serial number label for the K6460 Triple 
Quad MS is located on the lower left corner to the left of the instrument 
power push button.

2 Use at least four people, one at each corner of the instrument, to lift the 
K6460 Triple Quad MS onto a stable bench or table. Be sure to comply with 
local standards on the limits that each individual is allowed to lift.

WARNING Do not lift the Triple Quad without enough assistance to do so safely. The instrument 
weighs up to 115 kg (255 lbs). Be sure to use correct lifting procedures to avoid 
possible injury.
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Instrument Installation 1
Step 2. Prepare to install the system
NOTE Do not lift from under the power switch bracket on the front left corner of the instrument. 
The bracket will bend. See Figure 6.

Figure 6 Do not lift from under power switch bracket
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1 Instrument Installation
Step 3. Set up the Agilent MS40+ pumps
Step 3. Set up the Agilent MS40+ pumps
Do these steps if your instrument include an Agilent MS40+ pump.

Before you begin, make sure that you have:

• Pump oil pan (p/n G1946-00034)

• Tygon 1/2-inch I.D. exhaust tubing (p/n G1946-80077)

• Agilent MS40+ foreline pump

• SW60 pump oil

• NW25 to 5/8-inch tube elbow (p/n G1960-20003)

• NW20/25 hinged clamp with wing nut (p/n 0100-1398) 

• O-ring (p/n 0905-1592)

• pump power cord (p/n 8121-1753)

If the system is installed with G3215A Mass Spec Bench, follow the 
instructions in the Mass Spec Bench User Guide to install the pump or pumps 
inside of the Mass Spec Bench.

1 Unpack the Tygon 1/2-inch I.D. exhaust tubing (p/n G1946-80077) and 
Pump oil pan (p/n G1946-00034) from the shipping kit.

2 Remove the Agilent MS40+ foreline pump from its shipping container.

Inlet (from MS)

Exhaust (to vent)

Oil Mist Filter

Oil Level Sight Glass

Oil Drain Plug (10 mm)

Oil Fill Plug (10 mm)
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Instrument Installation 1
Step 3. Set up the Agilent MS40+ pumps
3 Set the Agilent MS40+ foreline pump into the Pump oil pan (p/n 
G1946-00034).

The pan is used to catch any small amounts of oil that can seep out of the 
pump. The pan can also hold all of the oil in the pump in case of a 
catastrophic seal failure.

4 Cut an appropriate length of the Tygon 1/2-inch I.D. exhaust tubing (p/n 
G1946-80077).

5 Find the NW25 to 5/8-inch tube elbow (p/n G1960-20003) and the O-ring 
(p/n 0905-1592). Put the O-ring on the exhaust adaptor.

6 Locate one NW20/25 hinged clamp with wing nut (p/n 0100-1398), open the 
swing clamp, and use it to clamp the exhaust adaptor onto the oil mist 
filter. Connect the Tygon 1/2-inch I.D. exhaust tubing (p/n G1946-80077) to 
the exhaust adaptor.

7 Add the entire 1-liter bottle of SW60 pump oil to the foreline pump.

8 Plug the pump power cord (p/n 8121-1753) into the power inlet of the 
foreline pump. Secure the pump power cord in place using the retaining 
bale mechanism. Plug the other end into the Pump Expander assembly port 
labeled Foreline.

CAUTION Foreline pumps are shipped dry. Oil must be used for proper operation. Failure to add 
oil before a system is pumped down damages foreline pumps.
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1 Instrument Installation
Step 3. Set up the Agilent MS40+ pumps
Figure 7 Pump expander box ports for K6460
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Instrument Installation 1
Step 4. Connect the K6460 Triple Quad MS
Step 4. Connect the K6460 Triple Quad MS
1 Connect the rough hose (p/n G1969-20123) that is supplied in the ship kit 

to the KF-25 foreline pump hose connection on the back left of the 
instrument.

2 Connect the foreline pump hose to the KF-25 inlet adapter on the foreline 
pump.

3 Use the supplied hook/loop fastener tape to secure the drain bottle into a 
secondary containment tub.

4 Connect the spray chamber drain tube to the 1-inch fitting on the drain 
bottle. The drain tube can also be routed out the front of the Triple Quad if 
needed.

5 Attach the calibrant delivery system (CDS)/inlet module waste tubing from 
the solvent selection valve on the Triple Quad to the ¼-inch fitting on the 
drain bottle.

6 Connect a length of the ½-inch Tygon tubing to the ½-inch fitting on the 
drain bottle, and then connect the other end of the tubing to a vent 
connection that is separate from the vent used for the foreline pump.

CAUTION The drain bottle vent must be located away from the foreline pump vent to prevent 
the foreline pump exhaust from contaminating the Triple Quad spray chamber.
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1 Instrument Installation
Step 4. Connect the K6460 Triple Quad MS
Figure 8 Drain bottle

7 Install the gas filter(s):

For K6460 Triple Quad MSs without AJS ESI source:

a Cut an appropriate length of the 
1/4-inch PTFE gas tubing 
(G1946-80078) and connect to the 
nitrogen gas supply regulator or 
nitrogen generator.

b Use the supplied nut and ferrule kit 
(5183-0392) to attach the other 
length of tubing to the RMSN-4 gas 
filter. This configures the filter in 
series with the supply tubing. See 
Figure 9 as an example for 
assembling the gas trap in the correct 
configuration.

Spray chamber drain tube

Drain bottle vent

CDS inlet and LC waste fitting

Waste drain bottle

Secondary containment
(customer supplied)

Outlet to LC/MS

RMSN-4

Figure 9 Gas filter connected in 
series

Inlet from nitrogen gas 
source
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Instrument Installation 1
Step 4. Connect the K6460 Triple Quad MS
For K6460 with AJS ESI source:

a Cut an appropriate length of the 
1/4-inch PTFE gas tubing (p/n 
G1946-80078) and connect to the 
nitrogen gas supply regulator or 
nitrogen generator.

b Locate the 2 1/4-inch brass T-unions 
(0100-0088) and loosen the brass 
nuts on the T-unions. 

c Connect the other end of the supply 
tubing to the T-union. 

d Cut four 4-inch lengths of PTFE 
tubing from the supplied 10 meter 
length (G1946-80078). 

e Connect two of the 4 inch lengths to 
each side of the T-unions. Use the 
supplied nut and ferrule kit 
(5183-0392) to attach the other side 4 inch the tubing to the two RMSN-4 
gas filters. This configures the filters in parallel. See Figure 10 as an 
example for assembling the gas traps in the correct configuration.

Outlet to LC/MS

RMSN-4

Figure 10 Gas filter connected in 
parallel

Inlet from nitrogen gas 
source
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1 Instrument Installation
Step 4. Connect the K6460 Triple Quad MS
Figure 11 Power and gas connections on back left of the K6460

8 Set the pressure on the nitrogen supply regulator at 80 to 100 psi (550 to 
690 kPa). Turn on the nitrogen gas for a few minutes to purge the tubing 
and gas conditioner before you connect the nitrogen gas supply to the 
Triple Quad. Regulator pressures above 110 psi (760 kPa) cause nitrogen 
waste due to release from the bleed valve on the flow-control module.

9 Use the tubing cutters (p/n 8710-1709) supplied in the ship kit to cut an 
appropriate length of the 1/8-inch copper supply tubing (p/n 5180-4196) to 
connect from the outlet fitting on the collision cell nitrogen tank regulator 
to the nitrogen gas conditioner (p/n RMSN-2) for the collision cell gas, and 
then cut a second length of the 1/8 -inch copper supply tubing to connect 
from the nitrogen gas conditioner to the collision cell gas inlet fitting on the 
left side of the Triple Quad (see Figure 11). Secure the gas filters in a 
vertical position with tie wraps.

1/8-inch nitrogen gas 
connection for collision 
gas supply

Do not use!

1/4-inch nitrogen gas 
connection for drying 
gas supply
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Instrument Installation 1
Step 4. Connect the K6460 Triple Quad MS
Figure 12 Power and electrical connection at back left side of Triple Quad (K6460). If 
two LAN connections exist, make sure to use the upper connection.

10 Set the pressure on the Collision Cell supply regulator at 10 to 30 psi 
(70 to 210 kPa).

11 Connect the remote start cable to its connector on the back left side of the 
Triple Quad. See Figure 12.

12 Connect the foreline pump power cord into the foreline pump connector on 
the back left side of the Triple Quad. See Figure 12.

13 Verify the front power switch is in the OFF position.

Remote start connection

LAN connection from 
HUB/switch

AC line power 
connection

Foreline pump power 
cord connection/ 
Pump Expander 
Assembly control 
connection

CAUTION Do not attach the Collision Cell gas fitting to the nitrogen supply regulator at 80 to 100 
psi (550 to 690 kPa). Pressure to the Collision Cell Gas Flow Module greater than 30 
psi (210 kPa) can cause fewer collisions to be available for secondary collision 
induced dissociation (CID) and poor peak shapes, as well as poor high vacuum. The 
Collision Cell can use the same nitrogen supply as the regular supply (i.e. for drying 
gas, nebulizer, CDS pressure) if it is the required purity (99.999%) but it must be 
down-regulated to 30 psi (210 kPa).
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1 Instrument Installation
Step 4. Connect the K6460 Triple Quad MS
14 Plug the Triple Quad power cord into the Triple Quad power connector on 
the Triple Quad and the other end of the Triple Quad power cord into the 
wall outlet. See Figure 12.

15 Plug the Pump Expander Assembly power cord into the wall outlet.

 

Figure 13 Pump Expander Assembly box for K6460.
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Instrument Installation 1
Step 5. Install the spray chamber
Step 5. Install the spray chamber

Agilent Jet Stream ESI Source
Before you begin, check that you have these parts:

• Agilent Jet Stream (AJS) ESI source

• ESI-L Low Concentration Tuning Mix (p/n G1969-85000)

1 Remove the top cover by loosening the T10 lock screw and lifting off the 
instrument chassis.

2 Remove the AJS ESI source from the packaging inside the instrument 
chassis next to the e-Module. See Figure 14.

Figure 14 Packaging for AJS ESI source for K6460

3 Remove the foil that covers the spray chamber mount, and remove the 
shipping cover from the Electrospray spray chamber.

4 Put the nebulizer in the nebulizer adjustment fixture supplied in the 
shipping kit and check that the nebulizer needle is properly adjusted. The 
nebulizer needle should be even with the end of the nebulizer nozzle.

5 Install the nebulizer in the spray chamber.
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1 Instrument Installation
Step 5. Install the spray chamber
6 Install the spray chamber on the spray chamber mount, close the spray 
chamber, and fasten the latch. You may need to adjust the latch to ensure 
that the O-ring seals completely. Use a ¼-inch x 5/16-inch wrench to loosen 
the lock nut, and then adjust the latch to the proper fit, and then tighten the 
lock nut so that the latch maintains its adjustment.

7 Connect the high voltage and vaporizer cables to the connectors on the left 
side panel of the instrument. 

8 Connect the 1/8-inch nebulizing gas tubing from the Triple Quad mainframe 
to the nebulizer gas fitting.

9 Connect the 1/8-inch sheath gas tubing from the Triple Quad mainframe to 
the sheath gas fitting on the AJS ESI source.

10 Connect the PEEK tubing from the selection valve (inside the front cover) to 
the top of the nebulizer.

Figure 15 Connections for AJS ESI source

high voltage connection

vaporizer port

nebulizer gas

sheath gas
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Instrument Installation 1
Step 5. Install the spray chamber
11 Rinse the calibrant bottle three times with hot (60°C) water and then three 
times with methanol. Then rinse it once with acetonitrile.

12 Add the ESI-L Low Concentration Tuning Mix to the calibrant bottle.

13 Turn on the Triple Quad front power switch to start the pump-down of the 
Triple Quad. 

The foreline pump(s) will become quieter within a few seconds.

Agilent G1948B Electrospray Source
Before you begin, check that you have these parts:

• Agilent G1948B Electrospray interface (the G1948A Electrospray interface 
is not supported)

• Nebulizer spacer kit (p/n G1946-60254)

• ESI-L Low Concentration Tuning Mix (p/n G1969-85000)

1 Remove the foil that covers the spray chamber mount, and remove the 
shipping cover from the Electrospray spray chamber.

2 Install the nebulizer spacer as follows:

a Use a flat-bladed screwdriver to remove the two nebulizer shoulder 
screws from the top of the spray chamber.

b Use the two m3×8 Torx T10 screws to install the nebulizer spacer onto 
the top of the spray chamber.

c Install the two nebulizer shoulder screws into the top of the nebulizer 
spacer.

3 Put the nebulizer in the nebulizer adjustment fixture supplied in the 
shipping kit and check that the nebulizer needle is properly adjusted. The 
nebulizer needle should be even with the end of the nebulizer nozzle.

4 Install the nebulizer in the spray chamber.

5 Install the spray chamber on the spray chamber mount, close the spray 
chamber, and fasten the latch. You may need to adjust the latch to ensure 
that the O-ring seals completely. Use a ¼-inch x 5/16-inch wrench to loosen 

CAUTION Never use aliphatic, aromatic or halogenated hydrocarbons in the CDS. These solvents 
are not compatible with the O-ring in the CDS.
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1 Instrument Installation
Step 5. Install the spray chamber
the lock nut, adjust the latch to the proper fit, and then tighten the lock nut 
so that the latch maintains its adjustment.

6 Connect the 1/8-inch nebulizing gas tubing from the Triple Quad mainframe 
to the nebulizer gas fitting.

7 Connect the PEEK tubing from the selection valve (inside the front cover) to 
the top of the nebulizer.

8 Rinse the calibrant bottle three times with hot (60°C) water and then three 
times with methanol. Then rinse it once with acetonitrile.

9 Add the Electrospray calibrant to the calibrant bottle.

10 Turn on the Triple Quad front power switch to start the pump-down of the 
Triple Quad. 

The foreline pump(s) will become quieter within a few seconds.

CAUTION Never use aliphatic, aromatic or halogenated hydrocarbons in the CDS. These solvents 
are not compatible with the O-ring in the CDS.
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Instrument Installation 1
Step 6. Install the Agilent LC system
Step 6. Install the Agilent LC system
Before you begin, check that you have these parts:

• HPLC grade methanol, or better

• HPLC grade water, or better

1 Install the Agilent LC system. Follow its installation documents. Other LCs 
are not supported.

2 Connect the remote start cable from the Triple Quad to a Remote Start 
connector on the LC sampler, pump or other detector module only.

3 Install an Agilent G1369 LAN Interface card into the LC detector module if 
required. If a detector module is not present, install the Agilent G1369 LAN 
Interface card into the pump module. Before you install the LAN Interface 
card, set switches 5 and 6 to the ON position. This will force the Agilent 
LAN Interface Card to use its default IP address and subnet mask.

The default IP address is 192.168.254.11 and the default subnet mask is 
255.255.255.0.

CAUTION Do not use any other LAN interface card besides the G1369 (e.g. the older Jet Direct 
card J4100A).
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If you purchased a bundled K6460 Triple Quad MS system, the MassHunter 
Workstation software has been installed for you. In this case, start at “Step 4. 
Install the Data Acquisition program”.

If you are upgrading MassHunter software that is already installed, refer to 
the Upgrade Guide that came with your system.
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2 Software Installation and Configuration
Step 1. Set up the computer system
Step 1. Set up the computer system
1 Set up the PC:

a Unpack the PC and put it on a suitable bench top or table.

b Connect the keyboard, mouse, monitor and printer to the computer.

2 Install the network hub:

a Put the hub on the table next to the PC.

b Plug the power supply into the hub.

c Connect the power supply to a power outlet.

3 Connect one end of a Category 5, shielded twisted pair (STP) cable to any 
port (1 to 7) on the network hub. Connect the other end of the cable to the 
10/100 Base-T network card in slot 1 of the PC. The card should be labeled 
LC/MS.

Do not connect to port 8 on the hub/switch.

4 Connect a second Category 5 STP LAN cable from one of the open ports 1 to 
7 on the hub to the Agilent LAN Card in the pump or detector.

5 Connect a third Category 5 STP LAN cable from one of the open ports 1 to 8 
on the hub to the LAN interface connection on the LAN/MS control card in 
the Triple Quad instrument.

6 Install the printer if included with your system. See the installation 
documentation supplied with the printer.

7 Turn on the printer, hub, monitor, and PC, in that order.

The computer comes installed with software and the appropriate drivers 
for the installed accessories. 

8 When the computer starts, create a user account. This account will be used 
to acquire data. Do not use the Windows Admin account for this purpose.
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Software Installation and Configuration 2
Step 2. Check PC network card configuration
Step 2. Check PC network card configuration
1 Click Start > Control Panel, and then under Network and Internet, click 

View network status and tasks.

If Control Panel displays in Small icons view, click Network and Sharing 
Centers.

2 Click Change adapter settings.

3 From the list of network connections, double-click the network connection 
that corresponds to the instrument LAN connection.

4 Scroll down the list to Internet IP Protocol 4 (TCP/IPv4) (or Internet IP 
Protocol), select it, and then click Properties.

Figure 16 LCMS Connection Properties dialog box - Networking tab
Agilent 6460 Triple Quad Mass Spectrometer (K6460) System Installation Guide 31



2 Software Installation and Configuration
Step 3. Prepare for installation
5 Make sure the Network Adapter is set to these settings:

IP address: 192.168.254.1

Subnet mask: 255.255.255.0

Figure 17 Internet Protocol Version 4 (TCP/IP) Properties dialog box

Step 3. Prepare for installation
• Run Windows Update to make sure you have the latest critical updates and 

security fixes. 

Make sure Windows Update is completed before you continue.

CAUTION If you do not run Windows Update, your system can be vulnerable to security 
problems. Confirm that the LAN power management has not been activated by a 
Windows Update program.
32 Agilent 6460 Triple Quad Mass Spectrometer (K6460) System Installation Guide



Software Installation and Configuration 2
Step 4. Install the Data Acquisition program
Step 4. Install the Data Acquisition program
The installation of the Data Acquisition program includes installation of 
Optimizer and Study Manager. Do not separately install these programs.

1 Check that no other program is running on your system, including Windows 
Update.

2 Put the Data Acquisition installation disc into the disc drive.

The welcome page appears. 

3 Click Install Microsoft .NET 4.5. Follow the instructions to install 
Microsoft .NET 4.5.

4 Click Install MassHunter Data Acquisition Software, and then follow the 
instructions to install the software.

• In the License Agreement page, click I accept the terms in the License 
Agreement, and then click Next.

• In the Choose destination location page, click Next to accept the default 
destination location. 

The default is C:\Program Files (×86)\Agilent\MassHunter\Workstation\Acq.

• If prompted, in the Choose location for customer data files screen, 
check that the default of D:\MassHunter is displayed in the text box, 
and then click Next.

• In the Ready to install page, click Install.

The Setup Status page now appears.

• If you are asked to allow Agilent Technologies to install software on the 
computer, click Yes.

• If you get a message that indicates that the screen resolution is not set to 
the required resolution, click OK.

• If you see a Notepad window that prompts you to install other options, 
close the Notepad window.

• When the installation completion message is displayed, click Finish.

5 Make sure that the most current firmware for the K6460 is installed.
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6 Click Install MassHunter Data Acquisition Manuals, and then:

a Make sure all check boxes are marked.

b Click Start Copy.

Manuals for Help must be marked so that user guides can be opened from 
online Help after installation. Manuals can be marked to copy the user 
guides to a second location of your choice.

Video Maintenance Guide must be marked so that the animated 
maintenance instructions can be opened from online Help after 
installation.

7 Click Install Software Verification Tool if you need to qualify the 
installation.

Step 5. Install the Qualitative Analysis program
• Refer to the Offline Qualitative and Quantitative Analysis Installation 

Guide for the K6460 Mass Spectrometer to install the Qualitative Analysis 
program.

Do not install any other MassHunter program until instructed to do so.

CAUTION You must use the Run as administrator option to install the program. Failure to do so 
can result in an incomplete installation, which can cause the system to run unreliably.
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Step 6. Install the Quantitative Analysis program
• Refer to the Offline Qualitative and Quantitative Analysis Installation 

Guide for the K6460 Mass Spectrometer to install the Quantitative Analysis 
program.

Do not install any other MassHunter program until instructed to do so.

Step 7. Install Microsoft Excel (optional)
The MassHunter Qualitative Analysis and Quantitative Analysis programs 
include PDF-based report templates. You need to install Excel only if you want 
to use custom Excel report templates. 

• Refer to the Offline Qualitative and Quantitative Analysis Installation 
Guide for the K6460 Mass Spectrometer to install Excel.

Do not install any other MassHunter program until instructed to do so.

Step 8. Install Service Packs for Data Acquisition
Make sure that you install Service Packs specifically for K6460, if available.

1 Put the Data Acquisition installation disc into the disc drive.

If you received a separate Service Pack installation disc, insert that disc 
instead.

2 If the folder Service Packs exists on the installation disc, then:

a Open the Service Packs folder. If the folder contains another folder, such 
as SP1, open that folder. 

b Locate the installation file, which ends with SP x.exe.

c Right-click the installation file and select Run as administrator. 

d Follow the instructions to install the service pack.

CAUTION You must use the Run as administrator option to install the program. Failure to do so 
can result in an incomplete installation, which can cause the system to run unreliably.
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Step 9. Install Quantitative Analysis Reporting
• Refer to the Offline Qualitative and Quantitative Analysis Installation 

Guide for the K6460 Mass Spectrometer to install the Quantitative Analysis 
Reporting program.

Do not install any other MassHunter program until instructed to do so.

Step 10. Configure Excel for MassHunter (optional)
• Refer to the Offline Qualitative and Quantitative Analysis Installation 

Guide for the K6460 Mass Spectrometer to verify the installation of Excel 
Add-Ins for MassHunter.

CAUTION You must use the Run as administrator option to install the program. Failure to do so 
can result in an incomplete installation, which can cause the system to run unreliably.
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Step 11. Configure the instrument
If available, configure the device from the Device Configuration tool in the 
Data Acquisition program. Go to Tools > Device Config.

Some HPLC instrument setups can be configured only through the Device 
Configuration tool from the Data Acquisition program. The Capillary Pump 
and the Nano pump with the Chip Cube are examples.

In this step, you configure the K6460 Triple Quad MS and the HPLC 
instrument.

1 Open the Agilent MassHunter Workstation folder on the desktop, and then 
double-click Acq Tools.

2 Double-click the Instrument Configuration tool.

3 If you are prompted to log in to OpenLAB, provide the user name and 
password for an OpenLAB administrator account.

You are prompted if OpenLAB Shared Services is installed on this 
computer.

4 In the Instrument Configuration dialog box:

a If you want to change the name of the instrument, type a new name for 
Instrument name.

b Mark the Mass Spectrometer check box.

c Click the option for your LC/MS instrument.

d Mark the Agilent LC (1100/1120/1200/1220/1260/1290)/CE check box.

e Click Agilent LC System Access.

f Click Device Config and configure the LC system.

g Click OK.
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Step 11. Configure the instrument
Figure 18 Instrument Configuration Dialog Box

5 When configuration is completed, click OK.
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Step 12. Copy the support folder to the computer
In this step, you copy the \Support folder from the Data Acquisition 
installation disk to the D:\MassHunter\ folder.

1 In a Windows Explorer window, open the installation disk drive.

2 Right-click the Support folder and click Copy.

3 Right-click the D:\MassHunter folder and click Paste.

4 In Windows Explorer, right-click the D:\MassHunter\Support folder and click 
Properties.

Figure 19 Support Properties dialog box

5 Clear the Read-only check box, and then click Apply.

The Confirm Attribute Changes dialog box is displayed. 
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Figure 20 Confirm Attribute Changes dialog box

6 Click Apply changes to this folder, subfolders and files, and then click 
OK.
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Step 13. Confirm the LC firmware revision
1 Start the Data Acquisition program.

2 Click File > Print > Instrument Configuration Report.

3 Click Screen.

4 Click OK.

5 Go to 
http://www.chem.agilent.com/_layouts/agilent/downloadFirmware.aspx?w
hid=69761 and check that you have the most recent firmware for the K1260 
LC instrument.

6 If you need to update your LC firmware, follow the instructions on the web 
site. Make sure you use the latest firmware update tool, as instructed on the 
web site.

7 Check that the firmware for the G1369A Agilent LAN Interface card is the 
latest version available:

a Start a Command Prompt in Windows.

b Type telnet 192.168.254.11 in the Command Prompt window and 
press Enter.

c Type / in the Telnet window.

The LAN Interface card displays its current configuration information.

The LAN Interface card requires 1.10 firmware or higher. If an upgrade is 
needed, please contact your Agilent representative.
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Step 14. Finish the installation
Step 14. Finish the installation
1 Create a system recovery disc of your installed system.

Check with your IT department for the appropriate backup procedure.

2 Install or enable any other program that you will use with your MassHunter 
workstation. Refer to the installation guide or quick start guide for these 
programs.

3 Make sure that the trust settings in Excel are set for all MassHunter users, 
including the guest account that is set up for compliance. See the Offline 
Qualitative and Quantitative Analysis Installation Guide for the K6460 
Mass Spectrometer for more information.

4 Run the installation program for the K6460 Resource Disc to install the 
K6460 manuals to your MassHunter Workstation.
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This chapter contains the steps needed to complete the hardware setup and 
verify the performance specifications of the installed system.
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Step 1. Condition the Agilent LC instrument
Step 1. Condition the Agilent LC instrument
Before you begin, check that you have:

• 18 M, HPLC grade deionized water (p/n 8500-2236)

• high-purity HPLC grade isopropanol

• premixed LC flushing solvent (50:25:15:10 
isopropanol/acetonitrile/cyclohexane/dichloromethane) 
(p/n G1969-85026)

• high-purity HPLC grade acetonitrile (p/n G2453-85050)

• high-purity HPLC grade methanol (p/n 8500-1867)

• high purity formic acid (p/n G2453-85060)

• for 6470/6495: RRHD Zorbax Eclipse Plus C18 trapping column 
(p/n 959757-302)

1 Flush the LC system. 

This flushing procedure is very effective at reducing background 
contaminants from the LC systems when they are interfaced with a mass 
spectrometer. The flushing procedure must be done for each solvent 
channel to ensure contaminants are removed from separate degasser and 
pumping channels.

2 Remove any column(s), install a restriction capillary, and bypass the flow 
cell for the UV detector, unless it is rated for high-pressure (400 bar) 
operation. Route the outlet capillary to a waste container. 

3 If required by your degasser model, connect A1/A2 degasser channels in 
series and B1/B2 degasser channels in series. Use the c-tubes included with 
the degasser. 

Don't try to re-use solvents used for the flushing procedure.

4 Use a hand-held controller or the Data Acquisition program to set up the 
pump module to deliver deionized water for 15 minutes at 3 mL/minute to 
remove any salt buffers. Do 5 injections with deionized water to clean the 
injector path and sample loop.

5 Set up the pump module to deliver HPLC grade isopropanol for 5 minutes at 
3 mL/minute. Do 5 injections with isopropanol to clean the injector path 
and sample loop.

6 Set up the pump module to deliver the premixed LC flushing solvent 
(50:25:15:10 isopropanol/acetonitrile/cyclohexane/dichloromethane) for 15 
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minutes at 3 mL/minute. Do 5 injections with the flushing solvent to clean 
the injector path and sample loop.

Alternatively, while the K6460 Triple Quad MS pumps down, the flushing 
solvent can be pumped at a low flow rate (e.g. 0.1 mL/minute) overnight.

7 Set up the pump module again to deliver HPLC grade isopropanol for 5 
minutes at 3 mL/minute. Do 5 injections with isopropanol to clean the 
injector path and sample loop.

8 If applicable, remove the c-tubes from the degasser channels plumbed in 
series and reconnect the degasser tubing to the original configuration.

9 Install the column used for installation verification (p/n 959757-902) and 
wet the column with 100% methanol.

All columns shipped with the K6460 Triple Quad MS are shipped dry. Upon 
installation, these columns must be primed or wetted with Methanol to 
properly condition the column.

10 Set up the pump module again to deliver HPLC grade methanol for at least 
30 minutes at 0.5 mL/minute. Make sure that the solvent stream selector 
valve on the K6460 Triple Quad MS is set to waste position or the outlet 
tubing from the column is not connected to the instrument. 

If the HPLC Stack has a Thermostatted Column Compartment (TCC), set 
the temperature of the column compartment to 60°C to reduce the back 
pressure and to help remove any contaminants on the column.

11 For positive mode checkout:

a For Channel A, install 1 liter of water with 0.1% formic acid.

b For Channel B, install 1 liter of 100% acetonitrile.

CAUTION Make sure that the flushing solvent does not stay in the LC for an extended period of 
time (for example, several days) because the cyclohexane may be harmful to the pump 
seals.
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c Do 5 injections with the blank premixed mobile phase (70:30 water: 
methanol) to clean the injector path and sample loop.

12 Autotune the LC/MS in both Positive and Negative Ion Polarities after the 
system has reached equilibration (approximately 11 hours after initial 
pumpdown) and the Quadrupole Frequencies have been adjusted.

The factory provided instrument disc contains an Autotune file that can be 
copied to the MassHunter tune folder for the configured model: 
D:\MassHunter\Tune\QQQ\model

NOTE Up to 0.1 percent formic acid can be added to the solvent that you just prepared to help 
ionize the reserpine checkout sample. Do not add the formic acid until after you prepare 
the Reserpine checkout sample.

NOTE Use solvents that are at a minimum HPLC grade. Solvents that are acceptable for most LC 
applications may contain high levels of background that are detectable by the more 
sensitive LC/MS instrument. LC solvents used with the LC/MS instrument should be 
rated for both HPLC and pesticide, environmental, or GC/MS analyses. Use the highest 
purity solvents you can obtain. Acceptability of solvents must be empirically determined.
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Step 2. Reset the collision cell gas flow rate
Most parameters such as the collision cell gas flow rate work with values set at 
the factory. In case the default flow rate does not give a high vacuum reading 
in the acceptable range, follow the steps in this topic to:

• Determine the optimal flow rate (DAC steps) to achieve the correct high 
vacuum gauge reading.

• Enter this value into the SmartCard using the “back door” command.

Acceptable ranges are listed in Table 1.

1 Determine the optimal Flow Rate:

a Open a Command Prompt window (click Start > Run, type cmd and click 
OK).

b Type telnet 192.168.254.12 5123 to open a “back door” into the 
Triple Quad's MS Interface Card firmware.

c Press Enter.
d Find the high vacuum gauge reading in the Cell tab of the Manual Tune 

program.

e Type getccgasflow and press Enter to get the current value of the 
collision cell gas flow DAC.

NOTE High Vacuum measurements with Collision Cell gas turned off can vary depending upon 
how long ago the LC/MS instrument was pumped down. 

For best results, allow the instrument to pump overnight at Autotune settings, but with 
Collision Cell gas turned OFF, before taking the High Vacuum measurement.

Table 1 Acceptable vacuum ranges

Model Rough Vacuum High Vacuum 
(CC Gas OFF)

High Vacuum 
(CC Gas ON)

K6460 1.8 to 2.2 Torr 2.0 to 5.0 × 10-6 Torr 2.0 to 3.0 × 10-5 Torr
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f Use the setccgasflow command to adjust the Collision Cell DAC value 
in iterative steps until the High Vaccum reading on the instrument is 
within the acceptable range.

Typical values are between 550 to 650. As a guideline, adjust collision 
cell gas flow by 5 or 10 units at a time. 

The target High Vaccuum Pressure with CC Gas on is 2.0 x 10-5 Torr.

g Close the Command Prompt window:

>bye

NOTE Wait 20 to 30 seconds for the collision cell pressure and gas flow to stabilize after each 
adjustment.
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Step 3. Prepare the performance evaluation samples 
In this step, you dilute the supplied performance evaluation sample 
(reserpine) to the concentrations needed for the Triple Quad system checkout. 

Use the diluted samples within a day of dilution. Refrigerate the intermediate 
(first) dilution in the supplied bottle.

• Always rinse the graduated pipettes and volumetric flasks thoroughly with 
deionized water before and between each use.

• Use polypropylene labware for preparing performance evaluation samples, 
since glass vessels introduce unacceptable levels of sodium.

• Always rinse the autosampler vials and caps with the solvent mix used for 
sample dilution before filling them with the performance verification 
samples. This minimizes any background that can be contributed by the 
vials and caps. The vials may be run uncapped if the septa are found to be a 
source of background contamination.

Required Parts • 1 mL graduated pipette (p/n 9301-1423)

• 2 × 100 mL volumetric flasks (p/n 9301-1344)

• ES/APCI Positive Ion Performance Standard (p/n G2423A)

• Plastic bottle for storing first dilution (p/n 9301-1433)

1 Prepare 2 liters of a 60:40 mixture of acetonitrile:water w/ 0.1% formic acid.

2 Prepare the first dilution (50 pg/μL) reserpine:

a Use a clean graduated pipette to transfer 1.0 mL of the 5 ng/μL reserpine 
(p/n G2423A) standard to a pre-rinsed 100 mL volumetric flask.

b Dilute to the 100 mL mark with the 60:40 mixture of acetonitrile:water 
w/ 0.1% formic acid solution that was prepared in step 1. Invert the flask 
at least 10 times to ensure proper mixing of the checkout sample.

c Use 5 to 10 mL of this solution to rinse one of the plastic storage bottles 
and fill it with the remaining solution.

d Label this bottle “50 pg/μL reserpine” along with the preparation date.

3 Prepare the second dilution (500 fg/μL) reserpine:

a a Use a clean graduated pipette to transfer 2 mL of the 100 pg/μL 
reserpine dilution to a pre-rinsed 100 mL volumetric flask.

b Dilute to the 100 mL mark with the 60:40 mixture of acetonitrile:water 
w/ 0.1% formic acid solution.
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c Use 5 to 10 mL of this solution to rinse one of the plastic storage bottles 
and fill it with the remaining solution.

d Label this bottle “1 pg/μL reserpine” along with the preparation date.

4 Refrigerate this solution and use on the day it is prepared

This provides 1 pg reserpine amount that is needed for performance verifi-
cation.

Step 4. Set up methods and worklists
Before you begin, copy the methods and worklists according to your 
instrument model.

The methods are the same for each performance verification, regardless of 
whether a standard installation checkout or Marketing Bid Specification 
checkout is done.

For the appropriate method and worklist for your instrument, see Table 2, 
“Checkout methods and worklists,” on page 51.

Positive ion mode checkout conditions are found in “Positive Ion Mode 
Checkout Conditions” on page 72.

1 Click Method > Open and then load the appropriate MRM method. Change 
the method as needed to match the values found in “Positive Ion Mode 
Checkout Conditions” on page 72, and then save the method.

2 Click Method > Open and then load the appropriate scan method. Change 
the method as needed to match the values found in “Positive Ion Mode 
Checkout Conditions” on page 72, and then save the method.

3 Put the vials into the LC autosampler:

• Position #1: An empty, uncapped vial

• Position #2: A vial that contains the solvent used for dilution (solvent 
blank)

• Position #3: A vial that contains the checkout sample (500 fg/μL)

4 Click Worklist > Open, and then open the appropriate worklist.
50 Agilent 6460 Triple Quad Mass Spectrometer (K6460) System Installation Guide



Installation Completion and System Verification 3
Step 4. Set up methods and worklists
The worklist is set up to:

• Do one injection of the solvent blank with the scan method to collect 
background ion data.

• Use the MRM method for the remaining runs to do:

• one injection of the empty vial

• five injections of the solvent blank

• five injections of the checkout sample

Table 2 Checkout methods and worklists

Source Mode Positive Ion Mode
Installation Checkout

AJS Scan Method 6460 ESI_AJT Pos MS2 Scan Grad.m

MRM Method 6460 ESI_AJT Pos MRM Checkout Grad.m

Worklist 6460 ESI_AJT Pos MRM Checkout Grad.wkl

ESI Scan Method 6460 ESI Pos MS2 Scan Grad.m

MRM Method 6460 ESI Pos MRM Checkout Grad.m

Worklist 6460 ESI Pos MRM Checkout Grad.wkl
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Step 5. Verify the Triple Quad sensitivity
The Performance Specification Services (G6061A and G6067A) can be 
purchased only at the time of original Agilent 6460 Triple Quad Mass 
Spectrometer (Model K6460) System bundle purchase.

• For standard Marketing Bid Specification Services (G6061A for Positive Ion 
Mode), the same checkout conditions as the installation checkout methods 
are used.

Figure 21 Reserpine checkout worklist

1 Review the worklist to be sure that the method and data paths are correct. 
Check that the data file names given in the worklist are unique and have not 
already been acquired.

2 Run the Positive Ion Mode checkout worklist.

a Run the appropriate Positive Ion Mode checkout worklist.

b Load each solvent blank and reserpine peak into the Qualitative Analysis 
program.

c Generate Extracted Ion Chromatograms of the ion product (195.10 m/z 
for Positive Ion Mode).
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Figure 22 Extract Chromatogram dialog box for Reserpine (Positive mode)

d Smooth the extracted chromatogram by setting Smoothing Function to 
Quadratic/Cubic Savitzky-Golay, and Function width to 9 points.

e Integrate each reserpine peak, and click Calculate Signal to Noise. Use 
the General integrator.
Agilent 6460 Triple Quad Mass Spectrometer (K6460) System Installation Guide 53



3 Installation Completion and System Verification
Step 5. Verify the Triple Quad sensitivity
f Calculate the signal-to-noise using Height.
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g For standard sensitivity verification, or performed under standard 
Marketing Bid Specification Service:

Under Noise Measurement, for Noise definition, select Auto-RMS 
(available in MassHunter Qualitative Analysis B.05.00 and higher).

Set the Noise region boundary to Start time 0 minute and End time 1 
minute. Make sure that the noise region does not include the 
chloramphenicol peak (or reserpine peak for Positive Ion Mode).

Set the Noise region width to 0.075.

3 Generate a printout of each signal-to-noise calculation report for each 
solvent blank and sample injection. Include the chromatogram in the 
printout.

4 Open the Excel spreadsheet D:\MassHunter\Support\Checkout\Sensitivity 
Checkout Report.xlsx. Fill in the values to calculate the average signal to noise 
and save the spreadsheet. 

The average signal-to-noise must be greater than that listed in these tables, 
depending on the checkout type. See Table 3 on page 57.

Figure 23 Calculate Signal-to-Noise dialog box (for an installation checkout or standard 
marketing Bid Specification Service checkout), shown with Noise region 
width of 0.075.
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5 Generate a printout of the Excel signal-to-noise report.

6 Change solvents (to A = water w/0.1% formic acid and B = acetonitrile for 
Positive Ion Polarity).

7 Clean the injectors. See step 11 on page 45.

8 Equilibrate the column for 1 hour at 30:70 A:B.

Figure 24 Example of a Positive mode signal-to-noise report.
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Table 3 K6460 Positive Mode Specifications

Mode G1948B Electrospray Agilent Jet Stream

Sensitivity Performance 5,000:1 (Auto-RMS,1 pg) 15,000:1 (Auto-RMS,1 pg)

G6061A Marketing Bid 
Sensitivity Performance

10,000:1 (Auto-RMS, 1 pg) 30,000:1 (Auto-RMS,1 pg)
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To install the G1947B APCI source 60
To verify the operation of the G1947B APCI source 61

This chapter contains the steps needed to install and verify the operation of 
the APCI source.

If the APCI source was purchased with the K6460 Triple Quad MS, you will 
need to install the source and verify its operation.

You can complete only a check tune with the different source types: G1948B 
and G1978B. Make sure you use the correct tune calibrant.
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To install the G1947B APCI source
To install the G1947B APCI source
1 Install these parts from the APCI enablement kits that ship with the 

G1947B APCI source into the Aux module on the K6460 Triple Quad MS:

• APCI High Voltage Power Supply (p/n G1946-80058)

2 Pour the Electrospray calibrant back into its original bottle or another 
suitable container, rinse the calibrant bottle with acetonitrile, pour the 
APCI calibrant into the calibrant bottle, and attach the calibrant bottle back 
onto the CDS.

3 Remove the electrospray source and install the APCI source:

a Put the nebulizer into the nebulizer adjustment fixture that is supplied 
in the shipping kit. Check that the nebulizer needle is properly adjusted. 
Make sure that the nebulizer needle is even with the end of the nebulizer 
nozzle.

b Install the nebulizer in the spray chamber.

c Remove the previously installed spray chamber. Install the standard 
spray shield if not already installed.

d Orient the standard spray shield so the off-axis hole is at the 12 o’clock 
position by loosening the two T10 screws that secure the end plate, 
orienting the spray shield, and re-tightening the two T10 screws (do not 
over-tighten). 

e Install the APCI spray chamber on the spray chamber mount, close the 
spray chamber, and fasten the latch. If needed, adjust the latch to ensure 
that the O-ring seals completely. Use a ¼-inch × 5/16-inch wrench to 
loosen the lock nut, adjust the latch to the proper fit, and then tighten 
the lock nut so that the latch maintains its adjustment.

f Connect the APCI corona and vaporizer heater cables to the connector 
on the left side panel of the instrument.

g Connect the 1/8-inch nebulizing gas tubing from the LC/MS mainframe 
to the nebulizer gas fitting.

h Connect the PEEK tubing from the selection valve (inside the front 
cover) to the top of the nebulizer.

WARNING Surfaces can be extremely hot. Let the instrument surfaces cool before you touch 
them.
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To verify the operation of the G1947B APCI source
There is no sensitivity checkout with the G1947B APCI source on the K6460 
Triple Quad MS. To verify its proper operation, run a manual tune with the 
G2432A APCI/APPI Calibration Solution.

Note that Auto Tune is not supported with this source.

1 Install the G2432A APCI/APPI Calibration Solution.

2 Check the tuning of the APCI source:

a In Data Acquisition program, set Context to Tune.

b Open the auto tune file that was generated with the electrospray source.

c In the Manual Tune tab, mark the Calibrant on check box, and then 
acquire the data.

d Verify that the masses in the MS1 and MS2 tabs are correct for the 
loaded source before you manually tune the peaks.

e Verify that you have sufficient abundance for the tune peaks, that the 
tune peaks have peak widths of 0.7 ±0.05 amu, and that mass 
assignments are within ±0.15 amu of the target mass assignments.

If needed, click Adjust Gain & Offset to establish the Mass Axis and 
Peak Width values. Repeat these for both MS1 and MS2 tabs.

3 Save the tune file.
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This chapter contains tasks that are related to setting up your K6460 Triple 
Quad MS.

For complete information on using the your K6460 Triple Quad MS, refer to 
the list of resources found in the Quick Start Guide.
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To start the Data Acquisition program
To start the Data Acquisition program
You can start the Data Acquisition program in one of two ways:

• Double-click the Data Acquisition icon in the Agilent MassHunter program 
group, or 

• Click Start > Programs > Agilent > MassHunter Workstation > Data 
Acquisition.

To stop MassHunter Engines
1 Close the Data Acquisition program.

2 Right-click the Engine Launcher icon in the system tray.

3 Click Shutdown Engines to stop the engines.

To start the MassHunter Engines, restart the Data Acquisition program. 
Alternatively, to start the MassHunter Engines without starting the Data 
Acquisition program, click Start Engines.

CAUTION Do not start Data Acquisition as administrator. (Do not right-click Data Acquisition 
and select Run as administrator.)
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To stop MassHunter processes in case of unrecoverable errors
When you stop MassHunter processes, loss of data can occur.

1 Click Programs > Agilent > MassHunter Workstation > Acq Tools > 
Remove MassHunter Processes.

2 Click Yes when you are asked whether you want to remove all MassHunter 
processes.

Only the Data Acquisition processes are stopped.

To view the log book
• Double-click the Acq System Logbook icon in the Agilent MassHunter 

program group, or click Start > Programs > Agilent > MassHunter 
Workstation> Acq System Logbook. 

You can also start the Logbook Viewer program within the MassHunter Data 
Acquisition program.
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To configure the network interface card
To configure the network interface card
The computer that is shipped with the K6460 Triple Quad MS is equipped with 
two network cards (LAN-cards). The first LAN-card is for connection to the 
“house network” (via 10/100/1000 Base-T network card). The IP address for 
this card can either be “static” or dynamically assigned (e.g. obtained by a 
DHCP server). By default, TCP/IP is configured as the network protocol for 
this card, which is built-in to the PC.

The second LAN-card (in slot #1) is dedicated for instrument communication 
with the K6460 Triple Quad MS and the Agilent 1100/1200 Series LC system. 
This network card should NOT be connected to the site LAN.

To verify is the Instrument LAN network card settings are correct, follow these 
steps.

1 Click Start > Settings > Control Panel.

2 Double-click Network Connections.

3 Right-click the icon for the network card for the house LAN, click 
Properties, and then configure the network card as needed.

Because this network card is independent from the card used for 
instrument control, it may be configured using a static IP address or using a 
DHCP server.

4 Right-click the icon for the network card for the K6460 Triple Quad MS, 
click Properties, and then check that these parameters are set:

• Subnet Mask 255.255.255.0

• Gateway - leave blank

NOTE Because network configurations vary widely from site to site, get assistance from an IT 
representative when you connect to the site network. Configuration by an Agilent 
Customer Engineer is on a best-effort basis only.
66 Agilent 6460 Triple Quad Mass Spectrometer (K6460) System Installation Guide



Other Setup Tasks 5
To remove the MassHunter Workstation software
To remove the MassHunter Workstation software
1 If you have any data, methods, libraries, or other files or directories that 

you want to save, and then move or copy them to a folder outside of those to 
be deleted.

2 Close all MassHunter Workstation programs, including the Data 
Acquisition, Qualitative Analysis and Quantitative Analysis programs.

3 Click Start > Control Panel > Programs and Features.

4 Remove these programs:

• Agilent MassHunter Workstation Data Acquisition

• Agilent MassHunter Workstation Qualitative Analysis

• Agilent MassHunter Workstation Quantitative Analysis

• Agilent MassHunter Workstation Quantitative Analysis Reporting

5 Close all applications.

6 Reboot the computer. You are now ready to install new software.
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To reconfigure the instrument
To reconfigure the instrument
If you have more than one stack of HPLC modules from which to choose, or a 
new supported LC module is installed, the Instrument Configuration registry 
must be cleared for MassHunter Workstation.

1 Put the K6460 Triple Quad MS into standby mode.

2 Close the MassHunter Acquisition program.

3 Stop MassHunter processes.

See “To stop MassHunter processes in case of unrecoverable errors” on 
page 65.

4 Start the Instrument Configuration program (Programs > Agilent > 
MassHunter Workstation > Acq Tools > Instrument Configuration). 

5 Mark the Mass Spectrometer check box, and then click the K6460 Triple 
Quad MS. Leave all other check boxes cleared.

Figure 25 Instrument Configuration

6 Click OK.
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To reconfigure the instrument
7 Start the MassHunter Workstation Acquisition program and confirm that 
only the MS instrument is available.

8 Close the Data Acquisition program.

9 Stop MassHunter processes.

10 Open Instrument Configuration again. 

11 Click the K6460 Triple Quad MS and mark the Agilent LC (1100, 1120, 
1200, 1220, 1260, 1290)/CE check box.

Figure 26 Instrument Configuration dialog box

12 Click OK.

The registry has now been cleared and configured for any new LC module(s).

Additional configuration steps may be required to set up LC devices.
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This chapter contains acquisition parameters for the checkout methods.

For a list of the checkout methods for each instrument, see Table 2, “Checkout 
methods and worklists,” on page 51.
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Positive Ion Mode Checkout Conditions
These conditions are used in a Positive Ion Mode checkout.

Post time of 3 minutes.

Table 4 HPLC Pump

Time %A (water w/0.1% 
formic acid)

%B (acetonitrile 
w/0.1% formic acid)

Flow

Initial 90 10 0.4 mL/min

0.1 90 10 0.4 mL/min

1 2 98 0.4 mL/min

4 2 98 0.4 mL/min

4.1 90 10 0.4 mL/min

5 Stop

Table 5 HPLC Autosampler

Injection volume 1 µL

Autosampler temperature 4°C

Needle wash flushport 70:30 methanol:water

Needle wash location Flushport, 3 seconds
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Table 6 Source parameters

ESI AJS

Gas Temp 350°C 325°C

Gas Flow 10 L/min 10 L/min

Nebulizer 60 psi 20 psi

Sheath Gas Temp 400°C

Sheath Gas Flow 12 L/min

Nozzle Voltage 0 V

Table 7 MS parameters

ESI AJS

Capillary 4000 V 4000 V

Collision Energy 41 V 41 V

Fragmentor 150 V 150 V

Accelerator voltage 7 V 7 V

Delta EMV 200 V 200 V

Time Filtering 0.03 min 0.03 min

Compound Reserpine Reserpine

Scan MRM MRM

MS1 Res Unit Unit

MS2 Res Unit Unit

Precursor Ion 609.3 m/z 609.3 m/z

Product Ion 195.1 m/z 195.1 m/z

Dwell 200 ms 200 ms

Low Pressure Funnel RF

High Pressure Funnel RF
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Sample (stock) Reserpine, 5 ng/µL Reserpine, 5 ng/µL

Concentration after 
dilution

1 pg/µL 1 pg/µL

Dilution solvent 60:40 aceonitrile w/ 0.1% 
formic acid: water w/ 0.1% 
formic acid

60:40 aceonitrile w/ 0.1% 
formic acid: water w/ 0.1% 
formic acid

Total sample amount 
injected on column

1 pg 1 pg

Sample order number 
(p/n)

G2423A G2423A

Table 7 MS parameters (continued)

ESI AJS
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